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IMPORTANT SAFETY INSTRUCTIONS
SAVE THESE INSTRUCTIONS

1 General Safety Instructions

This manual contains important instructions for Solectria models PVI 3800TL, PVI 5200TL, PVI
6600TL and PVI 7600TL that should be followed during installation and maintenance of the inverter.

Solectria models PVI 3800TL, PVI 5200TL, PVI 6600TL and PVI 7600TL inverters are designed
and tested to meet all applicable North American and International safety standards. However, like
all electrical and electronic equipment, safety precautions must be observed and followed during
installation and operation of Solectria inverters to reduce the risk of personal injury and to ensure a
safe installation.

Installation, commissioning, service, and maintenance of Solectria models PVI 3800TL, PVI 5200TL,
PVI6600TL and PVI 7600TL inverters must only be performed by qualified personnel that are licensed
and/or satisfy state and local jurisdiction regulations.

Before starting installation or commissioning of the Solectria PVI 3800TL, PVI 5200TL, PVI 6600TL
and PVI 7600TL, read through the entire manual and note all DANGER! WARNING! CAUTION!, and
NOTICE! statements.

All US electrical installations must comply and be in accordance with all the state, local, utility
regulations, and National Electrical Code ANSI/NFPA 70.

For installations in Canada, please ensure these are done in accordance with applicable Canadian
standards.

Ce guide contient d'importantes instructions concernant les onduleurs solaires Solectria modéle PVI
3800TL, PVI 5200TL, PVI 6600TL et PVI 7600TL qui devant étre observées au cours de l'installation
et de I'entretien de I'onduleur.

Les onduleurs solaires Solectria modéle PVI 3800TL, PVI 5200TL, PVI 6600TL et PVI 7600TL sont
congus et testés pour répondre a toutes les normes de sécurité nord-américaines et internationales
applicables. Cependant, comme pour tous les équipements électriques et électroniques, des mesures
de sécurité doivent étre respectées et observées durant 'installation et I'exploitation des onduleurs
Solectria afin de réduire le risque de préjudice corporel et de garantir la sécurité de I'installation.

Linstallation, la mise en service, I'entretien et la maintenance des onduleurs solaires Solectria
modele PVI 3800TL, PVI 5200TL, PVI 6600TL et PVI 7600TL doivent étre entreprises uniquement
par un personnel qualifi¢ autorisé et/ou répondant aux criteres des réglements locaux ou nationaux
applicables.

Lisez I'intégralité du manuel et prenez note de toutes les déclarations relatives a la sécurité sous les
rubriques intitulées DANGER ! AVERTISSEMENT ! PRUDENCE ! et AVIS ! avant de commencer
I'installation ou la mise en service des onduleurs solaires PVI 3800TL, PVI 5200TL, PVI 6600TL et
PVI 7600TL.

Toutes les installations électriques nord-américaines doivent étre conformes et respecter tous les
reglements des services publics, nationaux, locaux ainsi que le National Electrical Code ANSI/NFPA
70.

Pour toute installation au Canada, veuillez vous assurer que les installations sont conformes aux
normes canadiennes applicables.
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Safety Symbols and Terminology Definitions

DANGER!

DANGER!

CAUTION!
PRUDENCE!

c_’? nﬂ-“r:E

DANGER indicates a hazardous situation which, if not avoided,
will result in death or serious injury.

DANGER indique une situation dangereuse qui, si elle n’est pas
évitée, est susceptible de provoquer un décés ou des blessures
graves.

WARNING indicates a hazardous situation which, if not avoided,
could result in death or serious injury.

AVERTISSEMENT indique une situation dangereuse qui, si elle
n’est pas évitée, est susceptible de provoquer un décés ou des
blessures graves.

CAUTION indicates a hazardous situation which, if not avoided,
could result in minor or moderate injury.

PRUDENCE indique une situation dangereuse qui, si elle n'est
pas évitée, est susceptible de provoquer des blessures légeres
ou de degré moyen.

NOTICE indicates a situation that can result in property damage
if not avoided.

AVIS indique une situation susceptible de provoquer des
dommages a la propriété, si elle n’est pas évitée.

INFORMATION provided that when known and used will ensure
optimal operation of the system.

La connaissance et l'utilisation des INFORMATIONS fournies
garantissent un fonctionnement optimal du systéme.

HIGH VOLTAGE WARNING! Indicates hazardous high voltages
are present, which, if not avoided, will result in death or serious
injury. Thus, only authorized and trained personnel should install
and/or maintain this product.

AVERTISSEMENT HAUTE TENSION! indique la présence de
hautes tensions présentant un danger susceptibles de provoquer
un déces ou des blessures graves si elles ne sont pas évitées. Par
conséquent, linstallation et/ou I'entretien de ce produit doivent
étre entreprises uniguement par un personnel autorisé et formé.
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1.2

Hot surface

Surface chaude

Equipment grounding conductor (PE)

(PE) Equipement conducteur de terre

® B

Wait for a prescribed amount of time before engaging in the
indicated action.

N
&

(

Patientez le délai requis avant d’entreprendre I'action indiquée.

Safety Instructions

The inverter installation must be performed by an authorized electrician in accordance with the local
and National Electrical Code ANSI/NFPA 70 and OSHA requirements.

.

The inverter section contains no user-serviceable parts. For all service and maintenance,the
inverter should be returned to a Solectria Renewables, LLC.

Read all of these instructions, cautions, and warnings for the Solectria inverter and
associated PV array documentation.

Before connecting the Solectria inverter to the AC distribution grid, approval must be
received by the appropriate local utility as required by national and state interconnection
regulations, and must be connected only by qualified personnel.

In operation, the inverter wiring and connections can have hazardous high voltages and
currents present, thus only authorized and qualified personnel shall install and/or maintain
the inverter.

In some operation instances, the inverter chassis and heatsink surfaces may become hot.
PV solar arrays produce hazardous voltages and currents when exposed to light which

can create an electrical shock hazard. Use dark opaque sheets to cover the PV solar array
before wiring or connecting cable terminations.

Linstallation et la mise en service doivent étre effectuées par un électricien autorisé
conformément aux exigences locales et nationales ainsi qu’au National Electrical Code ANSI/
NFPA 70 et condition nécessaire OSHA.

L'onduleur ne comporte aucune piéce pouvant étre réparée par I'utilisateur. Afin de réduire
les risques de choc électrique, contactez le personnel d’entretien qualifié de I'usine a propos
des opérations d’entretien de Solectria Renewables, LLC.

Lisez toutes les instructions, rubriques Prudence et Avertissement de I'onduleur Solectria,
ainsi que la documentation sur le panneau photovoltaique associé.
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Avant de connecter 'onduleur solaire Solectria au réseau de distribution du courant alternatif
(CA), une autorisation doit étre obtenue de la part des services publics locaux de tutelle,
conformément aux réglements concernant I'interconnexion nationale et locale. La connexion
ne doit étre effectuée que par un personnel qualifié.

Des courants et des tensions de hautes intensités dangereuses peuvent étre présents dans
le cablage et les connexions de I'onduleur en marche, par conséquent, 'installation et/ou la

maintenance de I'onduleur doivent étre entreprises uniquement par un personnel autorisé et
qualifié.

Sous certains régimes de fonctionnement, le chassis de 'onduleur et les surfaces des
dissipateurs de chaleur peuvent devenir chaud.

Les panneaux solaires photovoltaiques produisent tensions et courants dangereux lorsqu’ils
sont exposés a la lumiére et constituent un danger de choc électrique. Couvrez le panneau
solaire photovoltaique a I'aide de morceaux de tissu opaques et foncés avant tout cablage
ou connexion des terminaisons de cable.

DOCR 070366-D 9



2 Introduction

With this device you have acquired an inverter for connection of a photovoltaic system to the grid.
This inverter is characterized by an advanced housing design and state-of-the-art high-frequency
technology, which enable the highest levels of efficiency and longest life.

The inverter includes key features and capabilities, such as Anti-Islanding protection, LCD, and
RS-485 interfaces.

The inverter is usable indoors and outdoors. It meets the requirements of ANSI/NFPA 70, NEC
690.5, UL 1741, IEEE 1547 and IEEE 1547.1 for parallel operation of power generation plants on
low-voltage network of regional electrical utility companies.

Anti Islanding

This inverter includes Active Anti-Islanding detection as required by UL1741/IEEE1547. The
inverter will automatically make small variations in reactive power output in order to detect a
possible islanding condition. If the grid is stable, these small variations will have negligible effects
on system voltage and frequency. However, in an islanded condition the small amount of reactive
power changes will force the system voltage or frequency to change significantly, which will trigger
the inverter to shut down.

In the following technical description, the precise functions are explained to the installer, as well as
the user, which are required for the installation, operational start-up and handling of the inverter.

21 System

The content of renewable energy with respect to overall power consumption worldwide is
increasing annually by approximately 25%. The reason for this rise can be primarily attributed to
the constantly increasing demand for power, the increasing interest in environmentally friendly
technologies, as well as the increasing costs of non-renewable energy.

By the use of renewable energy sources, the earth‘s atmosphere can be enormously relieved of
increases in CO2 and other harmful gases which result from power generation.

The solar inverter converts direct current from the solar cells into alternating current. This enables
you to feed your self-produced solar energy into the public grid.

Thanks to efficient MPP tracking, maximum capacity utilization of the solar energy plant is
ensured even in cases of misty and cloudy skies.

The string concept means that PV modules are always connected in series (in a string) and/or
that strings with the same voltage are connected in parallel to the solar inverter with the aim of
significantly reducing the photovoltaic system’s cabling requirements.

The fact that the modules are connected in strings also means that the photovoltaic system can be
perfectly matched to the solar inverter’s input voltage range.

The inverter is transformerless type without galvanic isolation. Therefore, the inverter may only be
operated with ungrounded PV arrays. Furthermore, the PV array must be installed in accordance
with the NEC 690.35 (Ungrounded Photovoltaic Power Systems) and the locally valid regulations for
ungrounded PV arrays. Additionally, the PV array (PV modules and cabling) must have protective
insulation and the PV modules used must be suitable for use with this inverter. PV modules with a
high capacity to ground may only be used if the array coupling capacity does not excessed 1,200
nF with 60Hz grid.
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2.2 Data Monitoring and Communication

The integrated data display, processing and communication of the device enables easy operation
of the solar inverter. Monitoring of the operational status and signaling of operational failures are
capable of being called up over the device display. The data interfaces enable the downloading
of data which can be evaluated with the aid of a PC system and allow continuous recording of
operating data.

The best way of accessing this functionality is via a monitoring system, such as SolrenView,
connected to your inverter.

The read-out of the data on the display is possible when the inverter is connected to AC voltage.

2.3 Technical Structure of the Inverter

The photovoltaic voltage is adjusted so that the maximum power output of the PV modules is also
achieved with different solar irradiation levels and temperatures (MPP Tracking). These inverters
have quite wide MPP range of suit for variety of PV modules by a variety of manufacturers. Measures
must be taken to ensure that the maximum no- load voltage of 600 V is never exceeded. Please
note that the maximum no-load voltage will occur at the lowest temperatures anticipated. You will
find more detailed information about temperature dependency in the data sheet for the PV modules.

The high-quality aluminum casing corresponds to protection degree NEMA 4 / IP65 (water-jet proof
and dust-proof) and is protected by an anti-corrosion finish. The heat sink on the inverters

is designed in such a way that operation of the inverter is possible at ambient temperatures from
-13°F to +122°F (-25°C to +50°C) at full power and optimal efficiency for either 240 V__or 208 V__
AC grids.

Metal fins designed into the rear side of the inverter chassis are used to dissipate heat and protect
the unit. An internal temperature control protects the interior of the device. In case of high ambient
temperatures, the maximum transferable power is limited.

The solar inverter is controlled by microcontrollers which provide interface communication and the
values and messages on the front-panel display.

AC grid monitoring is done by an independent dedicated micro controller set up to meet the
requirements of UL 1741 / IEEE 1547. This enables a connection of the solar inverter to the in-
house grid.

Operator protection requirements are met by electrically isolating the grid from the PV module. The
electrical isolation between the grid and the PV module is equivalent to basic insulation. Maximum
operator protection is ensured by reinforced isolation between the grid, PV modules and accessible
interfaces (display, RS-485 interface and fan port). Relevant standards concerning electromagnetic
compatibility (EMC) and safety are fulfilled.

The solar inverter is functional in grid-parallel operation exclusively. An automatic Anti-Islanding
function, guarantees secure disconnection in case of circuit isolation or interruptions in power
supply and avoid isolated operation.

DC Arc Fault Detection

The PVI 3800-7600TL inverters include DC Arc fault detection compliant with UL 1699B. The
inverter detects electrical noise that typically accompanies a DC series arc. The inverter will shut
down should the arc fault sensor detect a series arc.

DOCR 070366-D 1



DC Ground Fault Protection

The PVI 3800-7600TL inverters include residual current detection as part of the DC ground fault
detection method as required by UL1741. If there is a ground fault in the array, the inverter will
shutdown and display an error until the fault is cleared. GFDI Trip Limit: 300mA

24 Ambient Temperature

The inverter can be operated in ambient temperatures between -13°F to 158°F (-25°C to +70°C).
The following diagram illustrates how the power of the inverter is derated depending on ambient
temperature.

The device should be installed in a well-ventilated, cool and dry location.

o e
L ",| g
- a_‘: h,
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5- ‘:'\"
L] L2
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- s T \
- ¥
- LS Al
" e W W Figure 1 demonstrates typical behavior
T M, M,
oo g - Y — L for PVI 3800-7600TL series inverters.

Figure 1: Solectria PVI 3800-7600TL inverter output power vs ambient temperature curve

25 Inverter DC Input Voltage Range
Pac (W)
4.0kW |- 3.8kW PVI 3800TL
3.0kW -
Voc*  None- operating
range range
2.0kW |- g 9
*Voc: Voltage
of Open circuit
1.0kW =
PV input (V)
p B 120V § 1 1 1 P >
0 100V 200V 300V 400V 500V 600V

Figure 2: Solectria PVI 3800TL DC Input Voltage Range
Notice: Start up voltage is 150 V ; full power MPPT voltage is 200 V.

de’
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2.6

A Pac (W)
BOKWE 76/KM. ... PVI7600TL
6.6 kW l PV1 6600TL
6.0 kw}-
5.2 kW : PV 5200TL
""""""""" ; Voc*  None- operating
range range
4.0 kW
“Voc: Voltage
of Open circuit
2.0 kWP
PV input (V)
1120V 5 1 1 1 1 v -
0 100V 200V 300V 400V 500V 600V

Figure 3: PVI 5200TL, PVI 6600TL and PVI 7600TL PV input DC voltage range

Efficiency

The best efficiency of the inverter is obtained at input voltages > 320V, for 208V, _grid, and input
voltages > 380V for 240V, _grid.

Efficiency, %

100

95

90
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75
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—m— 330 Vdc

—f— 500 Vdc

70
0%

10% 20% 30% 40%  50% 60%  70%

% of Rated Output Power

80%  90%  100%

Figure 4: PVI 3800TL Efficiency Plot at 240V,
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Figure 5: PVI 5200TL, PVI 6600TL and PVI 7600TL efficiency plot at 240V
27 Equipment Overview
(1) —J

(2)
(3)
(4)

(1) Inverter Enclosure
(2) LED Indicators

(3)LCD (9)

(4) Keypad

(5) Mounting Bracket

(6) Lockable DC Disconnect Figure 6: Exterior view of inverter main components

(7) Wiring Box Cover
(8) Wiring Box
(9) Conduit Plugs
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A further description of the equipment features:

(1) Inverter Enclosure - This section is sealed at the factory and there are no user-serviceable
parts inside. All wiring to install the inverter is done in the wiring compartment.

(2) LED Indicators - The three LED indicators show errors or status as described in Section 5.

(3) LCD - The 20 character, 4 line LCD shows important messages regarding the inverter status
and performance.

(4) Display Control Keys - These 4 keys allow the user to access status and performance
information and to change settings via the display.

(5) Mounting Bracket - The inverter ships with a mounting bracket that allows for easy installation
of the inverter to a wall.

(6) Lockable DC Disconnect - The DC disconnect is lockable and allows DC power to be
disconnected from the inverter. See figure 7 below.

(7) Wiring Box Cover - This is the cover for the wiring compartment. The removal procedure is
shown on page 29. Please note the DC disconnect must be in the OFF position before this cover
can be removed.

(8) Wiring Box - This is the compartment where all the wiring for the inverter inputs and outputs
plus the RS-485 communication is done.

(9) Conduit Opening - There are six - 1 conduit openings and two - 1/2“ conduit openings. Each
conduit opening comes fitted with a conduit plug that should be removed before installing conduit
fittings. Conduit fittings need to be water tight with a NEMA 4, 4X, 6, or 6X rating.

Figure 7: Lockable DC Disconnect

DC Disconnect shown with lock in off position. There are three openings on the disconnect where
a lockout padlock can be attached as shown above.

DOCR 070366-D 15



2.8 Inverter Nameplate and Safety Labels
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Figure 8: Nameplate Label Location

The nameplate label is shown in Figure 8.

The inverter serial number can be found on the nameplate label.
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/A CAUTION

Risk of electric shock
Do not remove or destroy this label.
For connecting see manual
Do not remave cover. No user service-
able parls inside. Refer servicing
to qualified service personnel.

Both AC and DG voltage sources are
terminated inside this equipment.
Disconnect each circuit individually
before servicing

When the photovoltaic array is
exposed to light, it supplies
DC voltage to the equipment.

Risk of electric shock from energy
stored in capacitor. Do not remove
cover until 5 minutes after discon-
necting all sources of supply.

WARNING: ELECTRIC SHOCK HAZARD.
THE DC CONDUGCTQRS OF THIS PHO-
TOVOLTAIC SYSTEM ARE UNGROUN-
DED AND MAY BE ENERGIZED.

WARNING: Electric Shock Hazard. The:
DC conductors af this photovaltaic system

are normally ungrounded but will become
intermittently grounced without indication
when the inverter measures the PV array
isolation.

Hot surfaces. To reduce the
risk of burns, do not touch.

WARNING: MORE THAN ONE LIVE
RC ee diagram in manuai

CiR
A AVERTISSEMENT: PLUSIEURS CIRCUITS

SOUS TENSION. Voir le diagramme manuel

Figure 9: Location of Caution Labels

The warning label located in the wiring box enclosure as shown above indicates that there are
multiple live DC and AC wires.
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Figure 10: Dimensions of PVI 3800TL inverter

85in/216 mm

-:—!E
o TR iy

=

I ) T

) [
T RA
) [=

g:—B € T EED%E'
: i i
5 © im.

8.5in/218 mm

18 DOCR 070366-D



(:) ()

[
=
ey

hl‘:h-\_—u_ﬁ —
] o ]
1=} =) ES]
Bl s | 5§ L
| 30 0 Il
- [
L Ll I | 'ﬁ" .

) 9 4 5 6 (MO
Wiring box of PVI 3800TL solar inverter

(3) (4) (5) (6) (7) (8)
Wiring box of PVI 5200TL, PVI 6600TL and PVI 7600TL solar inverters

(1) String Fuse Holders (6) AC side Neutral

(2) RS-485 communication ports (7) AC side L1

(3) PV Positive Terminals (8) AC side L2

(4) PV Negative Terminals (9) Fuse bypass terminal
(5) Grounding Terminals

Figure 12: Wiring box connection options

Note: If a source circuits are pre-combined and fused, fuse bypass terminal may be used.

DOCR 070366-D
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Required torques for wiring box terminals

Terminals in Figure 12 Wire Size Permitted Required Torque*
3,4,5,6,7,8 2 i
(see location and description above) 14-6AWG (2.5 - 16 mm®) 10.5 in-Ibs (1.2 Nm)

Table 1: Required torques for wiring box terminals

3 Installation
CAUTION!
PRUDENCE!
CAUTION!
PRUDENCE!

=1=] MAFRLATRN
DRI

Read all of these instructions, cautions, and warnings for the
Solectria PVI inverter and associated PV array documentation.

Installation and commissioning must be performed by a licensed
electrician in accordance with local, state, and National Electrical
Code ANSI/NFPA 70 requirements.

The installation and wiring methods used in the installation of this
inverter in the U.S. must comply with all US National Electric Code
requirements (NEC) and local Authority Having Jurisdiction (AHJ)
requirements. In Canada, the installation and wiring methods used
must comply with the Canadian Electric Code, parts | and Il, and
the local AHJ requirements. System grounding when required by
the Canadian Electrical Code, Part 1, is the responsibility of the
installer.

These servicing instructions are for use by qualified personnel only.
To reduce the risk of electric shock, refer all servicing to factory
qualified service personnel. No user serviceable are contained
inside the inverter.

To reduce the risk of fire, connect only to a circuit provided with
dedicated circuit overcurrent protection in accordance with the
National Electrical Code, ANSI/NFPA70.

The unit or system is provided with fixed trip limits and shall not be
aggregated above 30KW on a single point of common connection.

In order to be able to carry out an accurate energy measurement,
a revenue meter measuring kWh may be used between the feed-in
point and the inverter.
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3.1 Visual Inspection

All Solectria PVI inverters are 100% tested, packaged in a heavy duty cardboard shipping
carton, and visually inspected before leaving our manufacturing facility. If you receive the inverter
in a damaged shipping carton, please reject the shipment and notify the shipping company
immediately.

Verify Solectria PVI shipping carton contains:

a. Correct Solectria PVI inverter model: PVI 3800TL, PVI 5200TL, PVI 6600TL or PVI 7600TL
b. Mounting bracket

c. Operation and Installation Manual

Visually inspect the Solectria PVI inverter for any physical damage such as a bent heatsink fin or
a dented chassis.

If the inverter appears to be damaged or if the inverter needs to be returned, please contact
Solectria customer service.

No user serviceable parts are contained in the inverter.
Do not attempt to open or repair the inverter. The inverter is

factory sealed to maintain its NEMA 4 rating. Breaking the
A seal will void the inverter warranty.

3.2 Installation Location

1. The inverter must be mounted vertically on a flat surface.

2. For clearances around inverter, see Figure 13.

3. Ensure the mounting hardware and structure can support the weight of the inverter.
4. Ensure the mounting hardware meets the appropriate building code.

5. Avoid installation on resonating surfaces (light construction walls etc.).
6. Installation can be indoors or in protected outdoor areas.
7. Avoid direct sun exposure.

8. Ensure inverter ambient temperature is within -13°F to +122°F (-25°C to +50°C) for optimal
efficiency of the PV system.

9. Chose a mounting height that allows easy access viewing of the display.

10. Despite having a NEMA 4 / IP65 enclosure with a soiling category lll certification, the
inverter must not be exposed to heavy soiling.

11.  Unused connectors and interfaces must be covered by sealing connectors.
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3.3 Mounting the Inverter

! FRLERTEA
[
EDOE
s k-
k|
B .

Please make sure the inverter is installed vertically.

>20" Inverter should be at least 20”
(50.8 cm) (50.8 cm) from any ceiling surface
>6" >6"
(15.2cm) (15.2 cm)
F\ =
-
>39" Inverter should be mounted at least 39”
(100em) | (100 cm) from the floor or ground surface.
v

Figure 13: Inverter clearances

The National Electric Code may require significantly larger working clearances (see NEC Section
110.26)
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Figure 14: Dimensional drawing of the mounting plate

1. Mount the mounting plate to the wall with at least 4 screws and anchors (& 1/4“). With 4
screws, use either all four 6.5mm mounting holes or all 4 slotted mounting holes. You can
use the mounting plate as a template for marking the positions of the boreholes.

2. Tighten the screws firmly to the wall.

Figure 15: Installing the mounting bracket and inverter on a wooden stud wall
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Using the mounting bracket as a template, mark four screw holes onto the wall. For 16 in.
(40.6 cm) on center stud mounting, use the four holes, marked A in Figure 4 on the prior
page. Make sure the holes are in the center of each stud before marking the drill location.

After marking the screw hole locations, drill the pilot holes for the appropriate screw type
that will hold the weight of the inverter in the selected material. 1/4* lag bolts are
recommended for mounting on wood framed walls.

Align the mounting bracket over the pilot holes and install the mounting hardware flush to
mounting surface. Please tighten to the recommended torque necessary to hold the
mounting bracket firmly to the wall surface.

Because the inverters are heavy, they should be lifted out of the cardboard container by at
least two people (PVI 3800TL weighs 43 Ibs (19.5 kg) and PVI 5200/6600/7600TL weigh
65 Ibs (29.5 kg)).

With two people, lift up the inverter and place it carefully onto the mounting bracket.

Check that the inverter is seated securely on the wall.

It is recommended to use stainless steel screws, especially if installed outdoors. Be sure to
verify sheer and pullout strength of anchors or other wall attachments.

3.4 Required Torques for PVI Inverters

Part Description Required Torque Tooling
Wiring Box Torx_ '_|'30 screws (x4) for att_a_chmg the max. 71 in-lbs (8 Nm) Torx T30
Cover Screws wiring box cover to the wiring box
erlqg Box 10mm nuts (x4) that secure the wiring max. 71 in-lbs (8 Nm) |10mm wrench
Interior Nuts box to the inverter stage assembly

Table 2: Required Torques for PVI inverters
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Electrical Connections

General Safety

A DANGER!
! ) ) DANGER!

CAUTION!
PRUDENCE!

CAUTION!
PRUDENCE!

Read all of the instructions, cautions, and warnings for the Solectria
PVI inverter and associated PV array documentation.

Installation and commissioning must be performed by a licensed
electrician in accordance with local, state, and National Electrical
Code ANSI/NFPA 70 requirements. Use 90°C (194 °F) copper solid
or stranded wire only for all DC and AC wiring to the PVI inverter to
optimize system efficiency. Size conductors per NEC requirements.

PV solar arrays produce hazardous voltages and currents when
exposed to light which can create an electrical shock hazard. Use
dark opaque sheets to cover the PV solar array before wiring or
connecting cable terminations.

Before connecting the Solectria PVI inverter to the AC distribution
grid, approval must be received by the appropriate local utility as
required by national and state interconnection regulations, and
must be connected only by qualified personnel.

Do not attempt to open or repair the inverter. The inverter is factory
sealed to maintain its NEMA 4 / IP65 rating. Breaking the seal will
void the inverter warranty.

The AC output circuits are isolated from the enclosure. When
required, providing PV system grounding electrode conductor
(GEC) is the responsibility of the installer. See NEC 690.41.
690.42, and 690.43.
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4.2 Utility AC Voltage

The Solectria PVI inverters operate grid-tied to the utility voltage. PVI inverters are software
configurable via the user display panel for various 208 V__or 240 V, 60 Hz service configurations
as shown in figures 16-22.

CAUTION! The Solectria PVI Inverters must never be connected to a
" 120 V__ utility service. NEC 690.64(b)(1) requires that the inverter
PRUDENCE! be connected to a dedicated circuit with no other outlets or devices

connected to the same circuit.

AC connection voltage and frequency limits:

Voltage range for 208 V nominal, line to line 183V -228V
Voltage range for 240 VV nominal, line to line 211V -264 V
Frequency Range 59.3 Hz - 60.5 Hz

Table 3: AC connection voltage and frequency limits

Grid configurations allowed:

240V £ 180°

PVI Inverter PVI Inverter

~|L1

PVI Inverter ﬁ

PVI Inverter

Figure 16: 240V/120V Split Phase AC Grid Figure 17: 208V Delta AC Grid
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240v £ 120°

Figure 20: 240V/120V Stinger-Leg AC Grid

Grid Configurations NOT Allowed:

Y
asov £ 120"_\
= z:‘::,R Rl N
Figure 21: 480V Delta AC Grid Figure 22: 480V/277V WYE AC Grid
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4.3 AC Circuit Breaker Requirements

A dedicated over current protection device in the building circuit panel is required for each
Solectria PVI inverter. There must be a circuit breaker or fuse to protect each AC phase, L1 and
L2. The over current protection device should be able to handle the rated maximum output voltage
and current of the inverter. Please refer to the table below to determine the appropriate circuit
breaker size to avoid potential fire hazards. The National Electrical Code (NEC), ANSI/NFPA 70
or applicable local electrical codes must be followed when determining maximum branch-circuit
over-current protection requirements.

Inverter Model Maximum AC Branch Protection
PVI 3800TL 2-pole, 20 A 208/240 V__
PVI 5200TL 2-pole, 40 A208/240 V__
PVI 6600TL 2-pole, 40 A208/240 V__
PVI 7600TL 2-pole, 40 A208/240 V__
4.4 Grounding Terminals

Each inverter comes with grounding terminals for use with DC Equipment Grounding Conductors
(EGC) and AC EGC. The grounding bars and the AC grounding screw terminal are bonded
together internal to the inverter. See NEC 690.47 for more information regarding requirements for
the grounding electrode system.

4.5 Lightning and Surge Protection

Solectria PVI inverters are designed and certified to meet stringent UL 1741 / IEEE 1547 and
ANSI/ IEEE 62.41/62.42 AC lighting and surge requirements; however, every PV installation is
unique, thus additional external UL/NEC AC and DC surge protection and solid grounding practice
are recommended. The inverter comes equipped with Type Il AC and DC Varistors.

Surge Suppression
This inverter includes surge suppression. The capabilities of the included surge suppression
capabilities are as follows:

STANDARD WAVEFORM PEAK VALUES
Surge Category Ring Wave Combination Wave
B 6 kV /0.50 kA 6 kV /3 kA

» “Standard 1.2/50 ps - 8/20 ys Combination Wave”
» “Standard 0.5 ps - 100 kHz Ring Wave”

4.6 Multiple Inverters

Multiple Solectria PVI inverters are permitted at a common location if all applicable NEC, state,
local building codes and local utility commissioning guidelines are met. However, each inverter
must have its own dedicated AC overcurrent protection device and a separate PV array.
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4.7 PV String Considerations

There are a large number of PV module string combinations that will offer optimal performance
from either the PVI 3800TL, PVI 5200TL, PVI 6600TL and PVI 7600TL inverters due to their wide
MPP DC voltage range (200 V — 500 V). Please use Solectria‘s online string sizing tool at
http://solectria.com/support/string-sizing-tool/.

If string sizing is done manually, follow the temperature
multiplication factors given in NEC 690.7 table or the PV module
manufacturer specified temperature coefficient to ensure PV string
voltage is less than < 600 V at minimum design temperature.

=] MFOEMATION
EE e et

CAUTION!
PRUDENCE!

Maximum DC/AC Oversizing is 1.4X

System wiring voltage losses should be no greater than 2 percent
on DC and AC side for optimal system efficiency and performance.

Inverter Model Maximum DC Power Connected
PVI 3800TL 5,320W

PVI 5200TL 7,280W

PVI6600TL 9,240W

PVI 7600TL 10,640W

The PVI 5200TL, PVI 6600TL and PVI 7600TL inverters have 2 separate MPPT zones. When
designing with two separate roof slopes or a shaded area in the array this allows for the
opportunity to isolate into one of the zones. To expand even further, the design provides options
for the two zones to handle mismatch. Each of the zones can process up to 67% of the total rated
power (even after oversizing). See the chart below:

Inverter Model Maximum DC MPPT1/MPPT2 Total Continuous
Power Connected 67% 133% Power
PVI 5200TL 7,280W 4877.6W / 2402.4W 5200W
PVI 6600TL 9,240W 6190.8W / 3049.2W 6600W
PVI 7600TL 10,640W 7128.8W /3511.2W 7600W

Note 1: The inverter total power output cannot be higher than the inverter rating. This mismatch
capability is just to further enhance design flexibility.

Note 2: In the chart above the extreme case of 67% / 33% mismatch is shown. Any combination
that is less than 67% for one zone and greater than 33% for the other would also work.

DOCR 070366-D
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4.8 Inverter Connections

4.8.1 General Information

WARNING!
AVERTISSEMENT!

WARNING!
AVERTISSEMENT!

WARNING!
AVERTISSEMENT!

DANGER!
DANGER!

CAUTION!
PRUDENCE!

WARNING!

AVERTISSEMENT!

Installation and commissioning must be performed by a licensed
electrician in accordance with local, state, and National Electrical
Code ANSI/NFPA 70 requirements.

Input and output circuits of this unit are isolated from the enclosure.
System grounding must be done in accordance with the National
Electrical Code (NEC). Compliance is the responsibility of the
installer.

Establish electrically safe work conditions by ensuring there are no
live voltages present on PV input and AC output circuits and that
all dedicated DC and AC disconnects/breakers are locked out and
tagged. Verify that the inverter’s DC disconnect and AC disconnect
are in the “OFF” position, before inverter installation.

PV solar arrays produce hazardous voltages and currents when
exposed to light which can create an electrical shock hazard. Use
dark opaque sheets to cover the PV solar array before wiring or
connecting cable terminations.

Before any electrical wiring can be connected to the inverter, the
inverter must be permanently mounted.

Use solid or stranded copper conductors only for AC and DC
connections. 6 AWG (16 mm?) is the maximum allowed wire size.

Inverter warranty is VOID if the DC input voltage exceeds the
inverter’s 600 V, maximum.

30
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Figure 23: PVI 3800TL Inverter electrical diagram

Siring A

IString B |

t=ring G
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Eoleciria PV Inverter
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Figure 24: PVI 5200TL, PVI 6600TL and PVI 7600TL Inverter electrical diagram
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A

POWER IS FED FROM MORE THAN ONE SOURCE, MORE
THAN ONE LIVE CIRCUIT EXISTS. Please see diagram above.

4.8.2 Opening the Wiring Box Cover

A

A\

DANGER!
DANGER!

Ensure no live voltages are present on PV input and AC output
circuits, and verify that the DC disconnect is in the “OFF” position,
and that are dedicated AC and DC disconnects/breakers locked out
before inverter installation.

PV solar arrays produce hazardous voltages and currents when
exposed to light which can create an electrical shock hazard. Use
dark opaque sheets to cover the PV solar array before wiring or
connecting cable terminations.

L

EEHEEE

g DC Disconnect switch in jﬁ

OFF position

#_ —_ = —_— e "=-_'ﬁ
Torx T30
Figure 25: Removing the wiring box cover
1. Place DC Disconnect switch in “OFF” position. Please note the cover cannot be removed

when the DC Disconnect switch is in the “ON” position.
Remove the 4 cover screws indicated above.

Lift the cover upward and place it off to the side.

32
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4.8.3 Wiring Box Conduit Openings

Conduit openings are provided for 1 inch and % inch conduit fittings. If the conduit fitting used
is between 1 inch and %z inch (2.54 cm and 1.27 cm), an appropriate conduit reducer should be
used.

== | car a5
‘ ‘ &/ 1/2in.

Figure 26: Wiring box conduit opening locations

. Do not enlarge the wiring compartment conduit openings as the
CAUTION! wiring box enclosure will be damaged which will void the inverter
PRUDENCE! warranty.

The conduit plugs are removed by
placing a flat head screwdriver in

the slot on the conduit plug face and
turning it while gripping the nut on
the inside of the enclosure. Unscrew
the nut from the conduit plug and slip
the conduit plug out of the conduit
opening.

Figure 27: Wiring box conduit plug removal
(illustration showing the removal of a conduit plug)
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Figure 28: Conduit installation and wiring routing
Conduit fittings need to be water tight with either a NEMA 4, 4X, 6, or 6X rating.

Once conduit and fittings are installed, route wiring through the conduit and fitting and allow a 6
inch strain relief service loop within the wiring box compartment.

4.8.4 PV Array String Input Connections

To ensure maximum protection against hazardous contact voltages

DANGER! while assembling photovoltaic installations, both the positive and
DANGER! the negative leads must be strictly isolated electrically from the

ground. All string fuses must be removed from the wiring box.

Risk of electric shock and fire. Use only with PV modules that
are listed for use with system voltage of 600V.

Electric shock hazard. The DC conductors of this photovoltaic
system are ungrounded and may be energized.

Electric shock hazard. The DC conductors of this photovoltaic
system are ungrounded but will become temporarily grounded
without indication when the inverter measures the PV array
isolation.

Verify all DC source circuit voltages and polarities with a
CAUTION! volt meter because damage to the inverter could result if
SRUEENES incorrect DC input voltages or polarity is connected to it. After
verification of correct voltage and polarity, DC fuses can be
installed.
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The PV Array positive or negative leads must not be connected to
3 ground.

All screw terminals accept solid or stranded copper 14 — 6AWG
E,'a N FHEATCRR wire only. A torque wrench with a flat head screw driver is
bl RORAAATION recommended for tightening screw terminals to a 10.5 in-lbs. (1.2

Nm) torque.
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PVI 5200TL/PVI 6600TL/PVI 7600TL wiring box diagram

Figure 29: PVI Wiring box - PV input connections

36 DOCR 070366-D



4.8.5

Verify that the exposed wires are at least 6 inches in length to provide adequate strain
relief and wire end strip length. Secure the conduit into both fittings then tighten conduit
fittings to manufacturer’s recommended torque.

Connect the positive lead from each PV array string to 1 of the PV Positive Terminals (A) in
the wiring box compartment. Using a torque wrench, tighten the screw terminal to 10.5 in-
Ibs (1.2 Nm) of torque.

Connect the negative lead from each PV array string to 1 of the PV Negative Terminals (B)
in the wiring box compartment using a torque wrench, tighten the screw terminal to 10.5 in-
Ibs (1.2 Nm) of torque.

Selecting PV String Fuse(s)

(A) 0 = 4 String Fuse Holders

é
:

@%@ Pl
= 4%/@ ® = 8 String Fuse Holders

Greunding Elsctreda

Figure 30: Fuse string locations
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4.8.5.1 PV String Fuse Information and Calculating String Fuse Size

The PVI 3800TL inverter is shipped with 4 x 15 A 600V Littlefuse KLKD 15 string fuses. PVI
5200TL, PVI 6600TL, and PVI 7600TL inverters are shipped with 8 X 15 A 600V _ Littlefuse KLKD
15 string fuses. The provided string fuses may or may not be appropriate for your particular
installation. Proper sizing of overcurrent protection is based on the maximum short circuit current
Isc (module) and calculated in accordance with NEC Article 690 requirements.

The maximum acceptable string fuse for the string combiner is 20A
PV (KLKD 20) fuse. Use of larger fuses will void the warranty.

The string fuse rating should never exceed the Maximum Series
Fuse Requirement provided by the module manufacturer. This
value is typically listed on the module label.

WARNING!
AVERTISSEMENT!

4.8.5.1.1 Calculating the Minimum String Fuse per NEC Article 690

The minimum string fuse size is calculated by multiplying the module Isc x 1.56.

For example: If you are using modules that have an Isc = 6.25 A, you would calculate the
minimum string fuse size as follows:

String Fuse (minimum) = 6.25 A x 1.56 = 9.75 A
A partial listing of the Littelfuse KLKD Fuses is as shown.

Part Number Amperage Type
KLK D 008. ....ccoeveieiiieieiee 8A

KLK D 009. ... ....PV Fuse
KLK D 010. ... ....PV Fuse
KLK D 012. ... ...PV Fuse

KLK D 015. ...
KLK D 020.

...PV Fuse
PV Fuse
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It is worth noting that for this example we calculated the minimum series fuse rating. However,

it may be appropriate to use the supplied 15 A fuses as long as they do not exceed the

maximum series fuse rating (provided by the module manufacturer) or the overcurrent protection
requirements of your PV source wires. Please reference the appropriate NEC Article(s) for further
discussion regarding proper sizing of overcurrent protection.

4.8.5.1.2 PV Fuse Properties

Other fuse manufacturers may have compatible fuse types. The generic properties are:

. Type: PV Fuse

. Fast-acting

. Dimensions: 1 1/2” in length x 13/32” fuse diameter
. Interrupt Rating: >= 10 kA @ 600 V

. UL and CSA approval of the fuse is mandatory

4.8.5.2 String fuse replacement

String fuses shall only be replaced by a qualified professional.

Ensure no live voltages are present on PV input and AC output

circuits, and verify that the DC disconnect, AC disconnect, and
dedicated AC branch circuit breaker are in the “OFF” position,
before attempting to replace DC fuses. With a DC amperage clamp

meter, ensure that there is no current flowing through the fuse to be
replaced.

S PV solar arrays produce hazardous voltages and currents when
A : exposed to light which can create an electrical shock hazard. Using

DANGER!

dark opaque sheets, cover the PV solar array before tampering or

reinserting PV string fuses

r\

Y [

Figure 31: String fuse replacement procedure
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Note: Refer to Figure 31 for String Fuse Locations.

1. Verify the absence of DC current in each string with a DC clamp meter.

2. Gripping only the plastic tab on top of the fuse extractor, pull straight upwards without
touching the fuse’s metal end caps or fuse-holder clips on printed circuit board.

3. Away from open wiring box compartment, open the fuse extractor door and tilt fuse
extractor downward with a hand underneath to catch fuse as it slides out of fuse extractor.

4. Next place the replacement fuse into fuse extractor and tilt upward to keep fuse from
dropping out. Close the fuse extractor door.

5. With fuse / fuse extractor parallel to empty fuse position, lower fuse extractor while aligning
fuse caps with open fuse clips. Then push downward until the fuse snaps into the clips.

Follow the same procedure for replacing the other string fuses.

4.8.6 Inverter AC Output Wire Connections
— Read all of the instructions, cautions, and warnings for the
A Solectria PVI Inverter and associated PV array documentation.
— Installation and commissioning must be performed by licensed

electrician in accordance with local, state, and National
Electrical Code ANSI/NFPA 70 requirements.

—  Ensure no live voltages are present on PV input and AC output
circuits, and verify that the DC disconnect, AC disconnect, are
in the “OFF” position, before inverter installation.

- Verify that the dedicated 2-pole 240 V, /208 V__circuit breaker
in the building electrical service panel is turned-off and locked

out.
All screw terminals accept solid or stranded copper 14 — 6 AWG
5_:'5 IMANERATIRE wire only. A torque wrench is recommended for tightening screw
b IPORMATIONS! terminals to a 10.5 in-Ibs (1.2 Nm) torque.
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Figure 32: Conduit installation and AC wiring routing

Conduit fittings need to be water tight with either a NEMA 4, 4X, 6, or 6X rating.

Once conduit and fittings are installed, route wiring through the conduit and fitting and allowing a 6
inch strain relief loop within the wiring box compartment.

Determine the AC voltage loss in the AC wires for a given wire cross section and wire length. The
following pages contain diagrams for each PVI inverter model to help determine the best wire
size for your particular installation. Solectria recommends that you select a wire size and length
to ensure a maximum voltage. Please note that the diagrams only show approximate voltage loss
and more precise voltage loss should be calculated by a licensed electrician in accordance with
local, state, and National Electrical Code ANSI/NFPA 70 requirements. The conductor size shall
not be smaller than the 75°C wire size based on the ampacities given in table 310.16 of the NEC,
ANSI/NFPA 70 and an additional derating factor of 125% as indicated by UL1741.
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PVI 3800TL

Percentage of voltage loss with 208 VAC and 240 VAC service. The load used in the calculation is
the max continuous AC current of the inverter.
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Figure 33: PVI 3800TL-AC voltage loss with different wire sizes and lengths

PVI 5200TL, PVI 6600TL and PVI 7600TL

Percentage of voltage loss with 208 VAC and 240 VAC service. The load used in the calculation is
the max continuous AC current of the inverter.
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Figure 34: PVI 75200TL, PVI 6600TL and PVI 7600TL AC voltage loss
with different wire sizes and lengths
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@) PE Terminal (AC System Ground) @® L1 Terminal
® N Terminal (® GET (Grounding Electrode Terminal)

@ L2 Terminal
Figure 35: Wiring box AC assembly — terminal labeling

Stranded copper wire should be checked for all strands inside the

G’ HOTICE! terminal opening.
A

D An additional external AC disconnect may be required by your
- local AHJ. Please check local regulations to determine if the AC
AVERTISSEMENT! disconnect is required for your installation.

-

Mount the external AC disconnect (if required by local AHJ) near the inverter.

2. Install conduit fitting and conduit into the wiring box compartment from AC disconnect or
utility service panel.

3. Route AC wiring through conduit and verify that the exposed wires are at least 6 inches
in length to provide adequate strain relief and wire end strip length. Secure the conduit into
both fittings then tighten conduit fittings to manufacturer’'s recommended torque.

4. Terminate inverter’s AC output wires inside the AC disconnect or junction box.

— Connect the AC system GND wire to the PE screw terminal (A) and using a 3/16” (4mm)
flat blade cabinet screw driver tighten the screw terminal to 10.5 in-Ibs (1.2 Nm) of torque.

— Connect the Neutral wire to the “N” screw terminal (B), and using a torque wrench, tighten
the screw terminal to 10.5 in-lbs (1.2 Nm) of torque.
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— Connect L1 wire to the “L1” terminal (D), and using a torque wrench, tighten the screw
terminal to 10.5 in-lbs (1.2 Nm) of torque.

— Connect L2 wire to the “L2” terminal (C), and using a torque wrench, tighten the screw
terminal to 10.5 in-Ibs (1.2 Nm) of torque.

Stranded copper wire should be checked for all strands inside the
terminal opening.

If a neutral wire connection is required for the connection grid to
make sure the neutral wire is securely connected to the neutral
terminal. Loose neutral wire connection will result in incorrect grid
voltage detection.

4.8.7 Inverter RS-485 Communication Connections

Read all of these instructions, cautions, and warnings for the

WARNING! Solectria PVI inverter and associated PV array documentation first.

AVERTISSEMENT!

Interface Connection RS-485
The Solectria PVI inverters offer an RS-485 communication interface which can address up to 16

daisy chained inverters. For optimal performance, the last inverter in the chain must always have
the termination jumper placed in the “on” position.

INV 1 INV 2 INV 16

EEEEEEEEEEEEEN TERM.
- oN
59
J1=RS-485 port 1 NOTE: Up to 1000’ total length of RS-485 cables
J2=RS-485 port 2 possible depending on site specifics.

SolrenView Gateway

Figure 36: Inverter RS-485 system diagram
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a The Termination Jumper is shown in the diagram on the left. To enable
!H termination place the jumper over the two upper pins next to the “on” label
on the board. To disable termination place the jumper in the off position on
= the lower two pins.

«—J1

= PR
[
-

Figure 37: RS-485 Termination Jumper

RS-485 Connector Pin-Out

Cannector pin assignment RS485
Fin

fi

hoi usad

kof uzad

ko uzad

GHND [RS48R)

ki usad

ki uzad

TH A(RS4RS)
Fx B RZ459)

LI I R IR VR

Top View

Figure 38: RS-485 connector pin-out

RS-485 Data Format

Baud Rate Programmable, 2400/4800/9600/19200/38400, default = 19200
Data Bit 8

Stop Bit 1

Parity N/A

Contact Solectria for available 485 cables for daisy-chaining multiple inverters or connecting
them to a SolrenView data monitoring logger.

4.8.8 SolrenView External Monitoring

The PVI 3800TL, 5200TL, 6600TL and 7600TL inverters include an option for a SolrenView
external gateway. This device can be used for the purpose of web-based monitoring and data

logging.
From the inverter a user can configure and monitor the inverter using a human-machine interface

(HMI). This HMI consists of the LCD display and four buttons.

The backside of SolrenView gateway provides connectivity to the data monitoring system.
Solectria’s SolrenView web-based data monitoring system can be interfaced using Ethernet over
twisted pair.

The inverter is not capable of powering the SolrenView data logger. A separate 12V wall power
supply is shipped with each data logger.
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%:gSOLECTRIA

RENEWABLES

Eac: 1200 kWh T
Pac: 3.8kW

Figure 39: SolrenView Gateway HMI

5 Commissioning the PV system

Read all of these instructions, cautions, and warnings for the

WARNING! Solectria PVI inverter and associated PV array documentation.
AVERTISSEMENT!

Installation and commissioning must be performed by a licensed
WARNING! electrician in accordance with local, state, and National Electrical
QVERTISSEMENT Code ANSI/NFPA 70 requirements.

Verify that the dedicated 2-pole 240 V, /208 V__ circuit breaker in

WARNING! the building electrical service panel is turned-off and locked out.
AVERTISSEMENT!

Wearing full PPE, with the disconnect in the “OFF” position, verify
the PV input polarity once more simply by carefully using a 600 V.
rated digital volt meter and probing the positive (+) and negative (-)
PV array connections.
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51 Status LEDs

No. Label Designation Color
(A) PowEeR Power Green
(B) GROUND FAULT Ground Fault Red

(©) ERROR Error Yellow

Information on the LED messages is provided in section 8. Diagnosis and maintenance”, p. 61.
5.2 Display and Keypad

5.2.1 Components

(A) Display

/
2 ® @ &

(B) Keys

5.2.2 Display Layout

=Date: DD.MM.YYYY
Time: 12h

The display has 4 rows of 20 characters each.
The first row contains the name of the currently displayed menu.
The second to fourth rows show the menu elements.

A small arrow in the third row shows the currently selected menu item.
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5.2.3 Keypad

Symbol Use

° Exit the current menu
ESG

®  Cancel the setting of a value

1.r ° Move upwards in a menu

®  Set a value (increase the value)

4’ ° Move downwards in a menu

®  Set a value (decrease the value)

®  Select a menu entry

d—l ®  Open a configurable value for editing

®  Finish editing (adopt the set value)

5.2.4 General Menu Structure

The menus have up to three levels:

[Main menu]

400 Production info
410 Current data
411 Current overview
412 Current data AC

420 Day statistics
430 Week statistics

500 User settings

Most menu names consist of a three-digit number and a menu title.

See Section 12.3 Overview of menu structure” for an overview of the complete menu structure.
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5.2.5 Menu Tree

Menu Tree

Install settings
Options
Production info
Diagnostic&Alarm
Inverter info
Standard menu

Install Settings

Date: MM.DD.YYY
Time: 24h

Grid: US 240D
Fnom: 60.00Hz

Vnom: 240V

Date: 12.22.2015 Pmax: 7.6kW

— Time: 9:40:24 Smax: 7.6kVA
Format CritUmax: 288V

CritUmax: 0.16s

Umax: 264V
Date and time — |—| Contrast: 5 | tUmax: 1.00s
. Display settings Umin: 211V
Grid selection tUmin: 2.00s
RS485 — I_ View grid setup Crit.Umin: 120V
Grid change ] Crit.tUmin:  0.16s
Fmax: 60.50Hz
tFmax: 0.16s
ID: 1 Fmin: 59.30Hz
Baudrate: 19200 tFmin: 0.16s
Dcinj.max: 200mA
tIsland: 0.20s

Key: 2A48A85B206
PIN: 0000
Grid: US 240 D

Options

Mode: high
Mode: high

Shading(MPPT1)  |— Key: 2A48A85B206
Shading (MPPT2) PIN: 0000
AFCI Settings Mode: enabled

AFCI Self Test
Arc Fault Clear ——

Mode: enabled
Normal operation

No
Yes
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Production Info

Production info

Now: 2169W
Day: 6221 Wh
Normal operation

L1 Voltage: 233V
L1 Current:  10.0A
L1 Freq.: 60.00Hz
L1P: 2422W
L1 Q: cap 1310Var

Current overview
Current data AC
Current data PV

PV1 Voltage: 363V
PV2 Voltage: 285V
PV1 Current: 3.5A
PV2 Current: 3.9A

Current data PV1
Current data PV2
Date and time
Current isolat

PV1 Voltage: 363V
PV1 Current: 3.5A

Day stat. AC
Day stat. DC
Day stat. ISO

PV2 Voltage: 285V
PV2 Current: 3.9A

Il T

Date: 12.22.2015

Current data
Day statistics
Week statistics

Week stat. AC
Week stat. DC
Week stat. ISO

Month statistics
Year statistics
Total statistics

L =

Month stat. AC
Month stat. DC
Month stat. ISO

Feed-in settings
Event journal
History

Year stat. AC
Year stat. DC
Year stat. ISO

Time: 9:40:24
Riso+: 3275kQ
Riso-: 3275kQ
Energy: 6682Wh

Runtime: 4:35h
Revenue: 2.45USD
L1 Imax: 17.99A
L1 Pmax: 3629W
L1 Qmax: ind OVar
L1 Qmin: cap 2165Var

Total stat. AC
Total stat. DC
Total stat. ISO

PV1 Imax: 5.1A
PV2 Imax: 5.6A
PV1Umax: 408V
PV2 Umax: 326V
PV1 Pmax: 1854W
PV2 Pmax: 1606W

’—I||

Currency: usD
USD/kWh: 0.35

Qtatiati
S

R iso max: 3868kQ
Riso min:  688kQ

External events
Change events

Day: 12.21.2015
Day: 12.20.2015
Day: 12.19.2015
Day: 12.18.2015
Day: 12.17.2015
Day: 12.16.2015
Day: 12.15.2015

Reset day stat.
Reset week stat.
Reset month stat.
Reset year stat.
Reset total stat.
Reset history
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Diagnostic&Alarm

Diagnostic&Alarm

Inverter info

ot DC: 01.04.01
nverter data ENS: 02.01.01

Standard menu

Standard menu Menu number: 411
411 Current overview

12.18.15 9:34:.04
471

Internal log

AC: 01.04.01

| Production data: 1518

Serial number:
230417021518000645

5.3 Inverter Turn-On Procedure

1.

Refer to Section 5 for commissioning process that needs to be completed
before the inverter can begin feeding power to the grid.

2. Turn on the DC disconnect (put in closed position).
3. Check for inverter initialization; all 3 LED indicators are illuminated.
4. Unlock and turn on the dedicated 2-pole 240 V, /208 V__ circuit breaker in the
building electrical service panel.
5. Turn on the AC disconnect.
5.4 Inverter Turn-Off Procedure
1. Turn off the AC disconnect.
2. Turn off the dedicated 2-pole 240 V__ /208 V__circuit breaker in the building
electrical service panel and lock it out.
3. Turn off the DC disconnect.
5.5 Standard Initial Commissioning
5.5.1 Brief Overview of the Commissioning Steps

— Select the grid voltage configuration

— Set up the RS-485 communication
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5.5.2 Detailed Description of the Commissioning Steps

1. Check all connections and cables for damage and correct seating. Correct the installation if
necessary.

2. Switch on the DC disconnect— The startup process of the inverter begins.

After the startup process and the automatic self-test, the initial commissioning procedure of
the inverter starts and the Installation menu is displayed.

3. Select a grid.

Grid Selection

-=Grid: us 208 D
Continue

Grids available for standard commissioning

Display text Description

US 208 D US 208 DELTA 3 PHASE SYSTEM

US 208 WYE US 208V/120V WYE 3 PHASE SYSTEM

US 240D US 240 DELTA 3 PHASE SYSTEM

US 240 STING US 240/120 STINGER LEG 3 PHASE SYSTEM
US 240 SPLIT US 240/120 SPLIT PHASE SYSTEM

4. Select Continue and press the key.

Grid Selection
Grid: Us 2088 D
=Continue

— The RS-485 menu is displayed
5 Set the RS-485 ID and the baud rate.

=1ID: 1
Baud Rate: 19200
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Configurable Parameters

Display text Designation Description
ID RS-485 ID 1..255
Baud rate Baud rate 2400 | 4800 | 9600 | 19200 | 38400, the standard is
19200
Connecting multiple inverters via RS-485.
? NOTICE!
A5 — If multiple inverters are to be connected via RS-485, select a

different ID for each inverter. This ID will also be used later to
identify each inverter when loading settings or transferring data.

6. Select Continue and press the key.

RS485
Baud Rate: 19200

+Continue

—> The last menu is displayed
7 Press the key to finish commissioning.

ENTER
to confirm
ESC
to reselection

Commissioning is now finished.
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5.6 Setting Values

You can set parameters in several menus. The keys are used to change parameter values.

The key increases the value of the parameter.

The key decreases the value of the parameter.

The key can be used to cancel the setting, and the original value is then displayed once more.

Pressing the key causes the new parameter value to be adopted.

The example on the next page illustrates the procedure for changing the value of a parameter.

This procedure is the same for all configurable parameters.
Example: Setting the date

Keys Action Result
1. Press the keys in the main PVI ## G4
'". \L menu to select the Install settings ~ _ __ ________________
menu.

=Install settings

Options

2. ..Press the key to open the 100
¢l Install settings (installation settings)
menu.

100 Install settings

->Date and time

Display settings

3. ..Pressthekeytoopen the 110 11@ Date and time
Pl Date and time menu. Format
-=Date: 18/@86/2013
Time: 13:10:20pm
4. UsethekeystoselectDate 110 Date and time
1r Jﬁ menu item. Format

- ’ 5. ..Press the key to begin making
the setting.

— The digits for the first value (in this
case the month) flash.

-=Date: 18/66/2013
Time: 13:10:20pm
06
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Keys Action Result

Tr J' 6. Use the keys to set the month.
a7
7. Press the key to adopt the new
. value.
18
— The digits for the second value (in
this case the day) flash.
1.r '.L 8. Use the keys to set the day.
15
9. ..Press the key to adopt the new
¢4 value..
2013
— The digits for the last value (in this
case the year) flash.
1-r 4' 10. Use the keys to set the year.
2014
11. ..Press the key to adopt the new
| value..

\' The value is adopted and the editing

- e 110 Date and time
mode is exited.

Format
-=Date: 15/07/2014
Time: 13:10:26pm
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6 Production Information

All energy production information is provided for informative

‘?‘ HOTICE! purposes only. An accurate external revenue grade meter provided
AxiS by the wiring company is the authoritative source of information for
invoicing.
6.1 Overview

The 400 Production info menu contains current data and statistics. The information is write-

protected and cannot be edited.

— Select the Production info menu item in the main menu.

— The 400 Production info menu is displayed.

400 Production Info

-»Current Data

Day Statistics
Structure of the 400 Production info menu

Sub-menu Content

Description

Current data for power, AC, PV,

410 Current data . )
insulation

“6.2 Current data”

420 Day statistics Statistics for AC, PV and ISO

430 Week statistics

440 Month statistics

450 Year statistics

460 Total statistics

“6.3 Other statistics”

Settings for currency and revenue per

470 Feed-in settings KWh

“7.3 Grid feed-in settings”

480 Event journal List of operating state messages

“8. Diagnosis and maintenance”

Statistics for the last seven days in

490 History which the inverter was in operation.

“6.3 Other statistics”
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6.2 Current Data

The current data values are provided in the menu 410 Current data.

Access

— Access the menu by navigating to Main menu > Production info > Current data.

— The 410 Current data menu is displayed.

41@ Current data

-=Current overview
Current data AC

Structure

Sub-menu

Contents and example display

411 Current overview

Current power and energy generation for the current day.
Current operating state (see “8. Diagnosis and maintenance”)

411 Current Overview

Now: W

Day: _Wh

Normal operation

If there are messages, the list of messages can be opened by press-

ing the key. For a detailed description, see chapter “8. Diagnosis
and maintenance”

412 Current data AC

Displays for: voltage, frequency, current, active power P, reactive
power Q

412 Current data AC

L1 Voltage: v
L1 Current: [ o Lk
LI (B[P |2 L= Rl

416 Current data PV

Data for: voltage, current

416 Current data PV

PV1 Voltage: ---V
PV¥1 Current: -.--A
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Sub-menu Contents and example display

41A Date and time Shows the current date and time.

Use the 110 Date and time menu to set the values, see “7.2.1 Date
and time”.

41A Date and time

Date: 18/66/2013
Time: 10:20:30

41B Current isolation Data for: maximum and minimum insulation resistances

41B Current isolat.

R iso+: _kn
R iso-: _kn

6.3 Other Statistics

Menu

420 Day statistics

430 Week statistics

440 Month statistics

450 Year statistics

460 Total statistics

490 History

Example display

420 Day statistics
Day stat. AC

--Day stat. PV
Day stat. ISO

The statistics for day, week, month, year and total production time all offer the same type of data.

The 490 History menu shows the statistics for the last seven days over which the inverter was in
operation.

490 History
Day: 10.16.12

-=Day: 16.10.12
Day: 10.10.12
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Structure

Sub-menu

Contents

421 Day stat. AC
431 Week stat. AC
441 Month stat. AC
451 Year stat. AC
461 Total stat. AC

Statistics for: total energy, runtime, revenue

Information on configuring the revenue settings is provided in “7.3

Grid feed-in settings”.
421 Day stat. AC

Energy: -===Wh
Runtime: -i--h
Revenue: --,=-=UsD
Displays for:

Af Minimum/maximum frequency
Imax Maximum current

AU Minimum/maximum voltage
Pmax Maximum active power
Qmax Maximum reactive power
Qmin Minimum reactive power

421 Day stat. AC

422 Day stat. DC
432 Week stat. DC
442 Month stat. DC
452 Year stat. DC
462 Total stat. DC

L1 Af: --.--/--.--Hz
L1 Imax: == (o |71
L1 AU: ---f---V
Displays for:

Pmax Maximum power
Imax Maximum current
Umax Maximum voltage

422 Day stat. DC

PV1 Imax: L[| {2
PV1 Umax: v
PV1l Pmax: W
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Sub-menu

Contents

423 Day stat. ISO
433 Week stat. ISO
443 Month stat. ISO
453 Year stat. ISO
463 Total stat. ISO

Statistics for: maximum/minimum insulation resistances

Pmax Maximum power
Imax Maximum current

423 Day stat. ISO

R ISO max: ----kn
R ISO min: ----k0
491 ... 497 Day ... Statistics for the last 7 days in which the inverter was in operation.
The statistics contain the same information as the menus 421, 422
and 423.
491 Day 18.06.2013
Energy: ----Wh
Runtime: -:--h
Revenue: --.--UsD
6.4 Deleting Statistics
Description

All statistics can be deleted (except for 410 Current data). The procedure is always the same.

1. Navigate to Production info > Feed-in settings > statistics.

— The 471 statistics menu is displayed.

471 Statistics
->Reset day stat.
Reset week stat.

Reset month stat.

2. Usethe keys to select the statistic you wish to delete (e.g., Reset day stat.) and

press the key.

— A confirmation query is displayed.

60

DOCR 070366-D



3. Select the option Yes and press the key to delete the statistic.

Reset day stat.

No
=>Yes

— A confirmation message is displayed.

Reset day stat.

Successful
Press Enter

The statistic for the day is deleted.
7 Settings

71 Overview

This chapter describes how to edit the configurable settings.
. Installation settings (Section 7.2 “Installation settings”)

. Grid feed-in settings (Section 7.3 “Grid feed-in settings”)
. Options settings (Section 7.4 “Options settings”)

. Standard menu (Section 7.5 “Standard menu”)

Information on operating the display is provided in Section 5.2 “Display and keypad”.

7.2 Installation Settings

Configurable settings

. Date, time

. Date and time format

. Contrast

. Grid configuration selection

. RS-485 settings
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7.21 Date and Time

Description
Menu 110 Date and time
Menu access Main menu > Install settings > Date and time

Example display

110 Date and time

Format
->Date: 18/06/2013
Time: 13:10:2@pm
Configurable Parameters
Display text Designation Description
Date Date Feedly configurable according to the selected date
format.
Time Time Feedly configurable according to the selected time
format.
7.2.2 Date and Time Formats
Description
Menu 111 Format
Menu access Main menu > Install settings > Date and time > Format
Example display ] HHHEE
-=Date: DD/MM/YYYY
Time: 13:10:20pm
Configurable Parameters
Display text Designation Description
DD.MM.YYYY
Date Date format DD/MM/YYYY
DD-MM-YYYY
Time 12h | 24h
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7.2.3 Contrast

Description
Menu 120 Display settings
Menu access Main menu > Install settings > Display settings

Example display 120 Display settings

Contrast: 18

Configurable Parameters

Display text Designation Description

Contrast Display Contrast 5..10

7.2.4 Grid Selection

DANGER! If the selected grid is changed, a completely new commissioning
A A ' process must be started, see Section 5. Commissioning the PV

DANGER! "
system”.

Always first contact the Solectria Support Team before changing
the selected grid!

You always require a PIN in order to enter the grid selection mode.
? HOTICE! You require a new PIN each time you wish to select a new grid
AN1E configuration. You obtain a key for the PIN from the Solectria

Support Team on request.

You must provide a key in order to receive a PIN. You will find the key in the menu 132 Grid
change.

1. To display the key, navigate to Main menu > Install settings > Grid selection> Grid
change.

132 Grid change

Grid: uUs 288 D
Key: HERREEEREEHA
PIN:  Confirm
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The key consists of 11 numbers and letters.
2. The Solectria Support Team will provide you with the four digit PIN.

3. When you have received the PIN, navigate to the menu 132 Grid change and press the
key.

— The first digit of the PIN flashes.

4. Use the keys to set the first digit and press the key to proceed to the next digit.

— After entering the full PIN, the word Confirm flashes.

PIN: 1234 Confirm
5. Press the key to confirm the entered PIN.
— The Installation menu is displayed.

Installation

->Language: English
continue

6. Start the commissioning of the inverter, see “5. Commissioning the PV system”.

7.2.5 RS-485

Description
Menu 111 Format
Menu access Main menu > Install settings > RS-485
Example display 140 RSA485
=»ID: 1
Baud rate: 19200
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Configurable Parameters

Display text Designation Description
ID RS-485 ID 1...255
Baud rate Baud rate 2400 | 4800 | 9600 | 19200 | 38400, the standard
is 19200
Connecting multiple inverters via RS-485.
q‘f| MOTICE!
A » Select a different ID for each inverter.

» A 220 ohm termination resistor must be connected to the last
inverter in the series (see “4.8.7 Inverter RS-485 Communication
Connections”).

NOTICE: An optional full-featured inverter direct data acquisition
G‘ HOTICE] and logging gateway and web-based service, SolrenView, is
L available from Solectria (http://www.solrenview.com). The gateway
allows the inverter to deliver information to the SolrenView server
through the facility’s internet service.

7.3 Grid Feed-In Settings
Description
Menu 470 Feed-in settings
Menu access Main menu > Production info> Feed-in settings

Example display 478 Feed-in settings

=Currency: usD
usD / kwWh: g.238

Configurable Parameters

Display text Designation Description

Currency Currency No pre-defined values.

No pre-defined values. The amount (USD) per

USD/kWwh USD/kWh kWh is required for the revenue calculation.
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7.4 Options Settings

Configurable settings

. Shading

. AFCI setting
. AFCI self test
. Arc fault clear

7.41 Shading

Description

The “Shading” option is an extended MPP tracker. When the option is switched on, the MPP
tracker performs an additional search at regular intervals.

The MPP tracker then searches for the maximum power over a wider voltage range.
This option should be switched on if shadows regularly pass slowly over the PV modules in
the course of a day. These types of moving shadows can be caused by chimneys or trees, for

example. Do NOT use this option for normal fast-moving shadows, e.g., from passing clouds.

The option is set depending on the size of the shading.

Menu 210 Shading
Menu access Main menu > Options > Shading
Example display

218 Shading

Configurable Parameters

Display text Designation Description

Mode Mode Disabled
Extended MPP tracking is disabled

High
High shading, time cycle: 0.5 hours

Medium

Medium shading, time cycle: 2 hours

Low

Low shading, time cycle: 4.5 hours
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7.4.2 AFCI Setting

BANEET If the AFCI setting is changed, a completely new commissioning
A DANGER! process will need to be started, see “5. Commissioning the PV
system”.
A PIN is required each time you wish to change the AFCI setting.
? HOTICE! You can obtain a PIN from the Solectria Customer Service Team
ANISI upon request.

You must provide a key in order to receive a PIN. You will find the key in the menu 230 AFCI
Setting.

1. To display the key, navigate to Main menu > Options > AFCI Setting.

230 AFCI Setting

Key: HERFEEHERHSE
SPIN:
Mode : enabled

The key consists of 11 numbers and/or letters.

2. The Solectria Customer Service Team will provide you with the four digit PIN.

3. When you have received the PIN, navigate to the menu 230 AFCI Setting and press the
button.

— The first digit of the PIN flashes.

4. Usethe buttons to set the first digit and press the (] button to proceed to the next
digit.

— After entering the full PIN, the word Confirm will flash.

230 AFCI Setting

Key: pbigigididibubigigi s
=PIN: 1234-sConfirm
Mode: enabled

5. Press the button to confirm the entered PIN.

— The AFCI Setting menu is displayed. You can enable or disable the arc detection
function through it.

AFCI Setting

-Mode: enabled
Continue
6. Start the commissioning of the solar power inverter, see “5. Commissioning the PV system”.
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743 AFCI Self Test

Description
The “AFCI Self Test” is a manual test function. When “enabled,”a self test of the arc detection

function will be carried out. If the internal circuit is OK, the inverter will show “AFCI Test Pass!” on
the display and shut down once the test passes. The inverter will start up again after the self test.

1. To display the arc self test, navigate to Main menu > Options > AFCI Self Test.

240 AFCI Self Test

->Mode: disabled
Normal Operation

2. To enable the AFCI self test, change the mode from “disabled” to “enabled”. When the test
passes, the mode will change back to “disabled”. The inverter will be shut down.

240 AFCI Self Test

>Mode: disabled
AFCI Test Pass!

3. The inverter will restart. The operation mode will show “normal operation” again.

7.4.4 Arc Fault Clear

Description

When an arc fault occurs, the inverter will shut down and the “Arc Fault Detected!” message will
be displayed. The inverter will remain off until the arc fault is cleared manually.

1. Check the operation mode of the inverter, navigate to Main menu > Production info >
Current data > Current overview. If an arc fault occurs “Arc Fault Detected!” will be displayed.

411 Current overview
Now : W

Day: _Wh
Arc Fault Detected!

2. To clear the arc fault status, navigate to Main menu > Options > Clear Arc Fault

Clear Arc Fault
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3. Select “Yes” and press the button.

Clear Arc Fault

Successful
Press Enter

4. Press the button. The display page will go back. The inverter will start up.

7.5 Standard Menu

Description

A standard menu can be defined, which is automatically displayed when the display keys are
not used for a certain period of time. When the standard menu is displayed, pressing the key
displays the main menu.

The standard menu is set to 411 Current data at the factory. This menu shows the current data
and current operating messages.

The number must be a valid menu number.
See “12.3 Overview of menu structure” for an overview of all available menu numbers.

1. Press the key to enter the menu number.
— The first digit flashes.
2. Enter the first digit of the menu number using the keys.

— You can only set menu numbers that actually exist. The name of the associated menu is
displayed in the fourth display row.

3. Once you have set the first digit, press the key.
— The second digit flashes.

4. Enter the second and third digit in the same manner.

5. Press the [2] key.

— The menu corresponding to the entered menu number is displayed.

Menu 800 Standard

Menu access Main menu > Standard

Example display
860 Standard menu

-=Menu number: 411
411 Current overview
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Configurable Parameters

Display text Designation Description

Menu number Menu number Any valid menu number.
8 Diagnosis and Maintenance
8.1 Operating States

8.1.1 Types of Operating States

Operating State Associated Influencing Factors Grid Feed-In

No factors are present that limit the energy

production results. Yes

Normal operation

Non-critical factors that can affect the energy
Limited operation production but which are not equipment or Limited
system failures (e.g., self-test).

Warning . . Yes
External events or internal failures are present

) that affect the production results.
Failure No

Insulation or

. . A problem exists with the insulation No
grounding failure

See section 8.1.2 for a description of the influencing factors.

Note: When in failure mode, the inverter will not produce power.

8.1.2 Factors Influencing the Operating State

Different influencing factors are assigned to the individual operating states. These influencing
factors are divided into the following categories.

Non-critical factors

Non-critical factors are (for example) the self-test or a DC voltage that is too low due to bad
weather. Non-critical factors are therefore not failures.

Events

Events are usually caused outside the inverter. Events are divided into external events (e.g.,
voltage or frequency errors) and parameter changes occurring via the keys or the RS-485
interface.

Internal failures

Internal failures are caused from within the inverter and must be corrected with help of the
Solectria Support Team.
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Insulation and grounding failures

Insulation and grounding failures are logged and displayed when this failure occurs. When an
insulation or grounding failure is indicated, the failure has to be corrected by the installer before

the inverter will restore power production.

8.1.3

Display of the Current Operating State

The actual operating state is indicated via LEDs. A short message is also shown in the fourth line
of the 411 Current overview menu.

411 Current Overview

Now:
Day:

W

_Wh

Normal operation

The 411 Current overview menu is automatically displayed when a new message arrives.

LED status Message category Display text in menu 411
Green  <ON> Normal operation Normal operation
Red <OFF>
Yellow  <OFF>
Green  <ON> Limited operation e.g. Self-test
Red <OFF>
Yellow  <OFF>
Green  <ON> General waming For external events: External events
messages
Red <OFF> For internal failures: Warning ### (3-digit number)
Yellow  <Flash>
Green  <OFF> General failure For external events: External events
messages
Red <OFF> For internal failures: Failure ### (3-digit number)
Yellow  <ON>
Green  <OFF> Insulatlpn or Insulation
grounding failure
Red <ON>
Yellow  <OFF>

The software defines which events trigger a warning and which events trigger a failure.
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8.2 Event Log

8.2.1 Overview
Menu 480 Event journal
Menu access Main menu > Production info> Event journal
Example display

480 Event journal

-+External events
Change events

The event journal contains the messages relating to the following events:

. Parameter changes - Changes to all parameters influencing the energy production and
therefore the revenue production.

. External events - Problems with the insulation and grounding

Sub-menu Description

481 External events Alist of all external events.

482 Change events A list of parameter changes made via the display or via RS-485.

8.2.2 External Events Menu

Description
Menu 481 External events
Menu access Main menu > Production info> Event journal > External events
Example display

481 External events
18.06.2013 17:29:56
L1 Islanding

Begin

The external event message has the following structure:

2nd line Date and time when the external event occurred.

3rd line Short description of the failure (see chapter "8.3 Troubleshooting and
correction")

. Additional information, e.g., "Begin" for the occurrence of an event or
4th line " " ;
End" for the disappearance of an event.
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8.2.3 Change Events Menu

Description

The 482 Change events menu contains a chronological list of all changes to parameters
influencing the energy production and thus also the revenue.

Menu 482 Change events
Menu access Main menu > Production info> Event journal > Change events
Example display

482 Change events

18.06.13 17:29:56 D
Max. power: 100%
Max. power: 0%

The parameter change entry has the following structure:

Menu 482 Change events

2nd line Date and time when the external event occurred.
Source of the change:
D: Display
E: External (RS-485)

S: System
3rd line Name of the changed parameter + previous value
4th line Name of the changed parameter + new value
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8.3 Troubleshooting and Correction
8.3.1 External Events / Insulation and Grounding Failures

The 411 Current overview menu shows one of the following messages:

411 Current overview
MNow: -W
Day: AWh
External events

411 Current overview
MNow : -W
Day: Alh
Insulation

1. To receive a more exact description of the problem, press the key in the 411 Current
overview menu.

— The External events menu is displayed.

External events
PV1 IS0 running fail

PV1 IS0 startup fail

The menu contains a list of all active messages relating to external events and insulation/
grounding.

2. Press the [d] key again.

— The 480 Event journal menu containing the detailed message text is displayed
(see "8.2 Event journal").

480 Event journal

->External events
Change events
3. Select the entry External events and press the key again.

480 Event journal

+External events
Change events
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— The 481 External events menu is displayed.

481 External events

18.86.2013| 17:29:56

L1 Islanding

Begin
Alternatively, you can also directly open the 483 External events menu via the “Go to menu”
function, see chapter "12.3.1 ‘Go to menu’ function".

The following table shows the failure messages that can appear in the 483 External events menu
and provides troubleshooting and correction suggestions.

LED Status Display message Message description Fault correction
Green  <ON> Warning ### Internal failure ("Warning" + three-digit number)
Red <OFF> » Please contact Delta Support.
Yellow  <Flash>
Green  <OFF> Failure ### Internal failure ("Failure" + three-digit number)
Red <OFF> » Please contact Delta Support.
Yellow <ON>
Green  <OFF> L1 Voltage AC overvoltage or undervoltage on phase L.
Red <OFF>  failure ;Izcgsrcrlzahted%rti: xc&lt)-age shown on the display (menu
Yellow <ON> » If no voltage is present, check the circuit breaker.
Green  <OFF> L1 Frequency AC high frequency or low frequency on phase L.
e g1 ey shoun n e g
Yellow <ON> t;e;fkr;?_ voltage is present, check the automatic circuit
Green  <OFF> L1 Islanding Frequency shift failure on phase L.
Red <OFF> a>Ct£;‘slkS%/E(’)tL;roefl(t.er::;rigriit(_\,j/-supply company about the
Yellow <ON> » Check the installation.
» Restart the solar power inverter. Contain your
maintenance technician if the failure persists.
Green  <OFF> PV Power too low The solar power is too low.
Red <OFF> Insufficient solar irradiation (dawn/dusk)..
Yellow <ON> » Check the PV cell voltage shown on the display

(menu 416 Current data PV).
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LED Status Display message Message description Fault correction
Green  <OFF> PV11SO startup The startup insulation is too low.
Red e fail » Check the insulation resistance at the DC side of
Yellow <OFF> the PV modules.
Green  <OFF> PV1ISO running Residual current excess the safety standard.
Red <ON>  fail » Check the insulation resistance at the DC side of
Yellow  <OFF> the PV modules.
8.3.2 Internal Failures

In the case of an internal failure, the message "Warning XXX" or "Failure XXX" is displayed in the

411 Current overview menu. XXX stands for a 3-digit failure number.

411 Current data

L1 W
Day: _Wh
Warning 123

411 Current data

L1 W
Day: _Wh
Failure 351

In the case of internal failures, always contact the Solectria Support Team (see address list on the
rear cover of this manual).
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8.3.3

Other LED and Display Messages

LED Status Display message Message description Fault correction
Green <Flash> The PV1 voltage is too low.
PV1 Voltage too low
Red <OFF> There is insufficient solar irradiation.
» Check the PV cell voltage shown on the display
el i (menu 416 Current data PV).
Green <ON> L1 Power reduction  Power reduction activefor L1.
Red <OFF> PV1 PW limit to Pn Power limiting active for PV1.
Yellow <OFF> PV1 Temp Tempfar.ature dera.tlng active for PV1. Reduced
derating electricity production.
The internal temperature of the solar power
inverter lies between +45 and +70 °C.
» Check the ventilation of the solar power
inverter.
» Prevent direct sunlight from reaching the solar
power inverter.
8.4 Displaying Grid Settings

Description

The actual grid settings can be displayed using the 131 View grid setup menu. The contents of
this menu are write-protected.

Menu

131 View grid setup

Menu access

Main menu > Install settings >Grid selection> View grid setup

Example display

131 View grid setup

=Grid: Us 208 D

Fnom: --.--Hz

If a power limit was set when the inverter was commissioned, then the following message is
displayed before the menu opens:

The maximum power
of that inverter
has been limited to

#Hi L HHEKW
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8.5 Internal Log

Description

The internal log contains information on the internal failures that have occurred.

Menu 620 Internal log
Menu access Main menu > Diagnostic&Alarm > Internal log
Example display

620 Internal log

BTV A U B O P = 3 M e
126 127

Parameter change entries have the following structure:

3rd Line Date and time when the external event occurred.

4th Line Number(s) of the internal failure(s)

8.6 Maintenance

/\ e — Lethal danger from hazardous voltage.

,% A DANGER! Hazardous voltage exists while the inverter is operating. Hazardous

VAR voltage may still be present 5 minutes after all power sources have
been disconnected.

» Never open the inverter. The inverter contains no components
/ \ that are user serviceable. Opening the cover will void the warranty.

Soa

Ensure that the inverter is not covered and has sufficient air flow during operation.

Regularly clean the inverter to prevent soiling of the enclosure.

9 Repair
A — Danger of death from hazardous voltage.

A A DANGER! Hazardous voltage exists while the inverter is operating. Hazardous
voltage may still be present 5 minutes after all power sources have
been disconnected.

» Never open the inverter. The inverter contains no components
/ \ that are user serviceable. Opening the cover will void the warranty.

Soa
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HOTICE!

The inverter contains no components that are user serviceable.
G A5

10 Removal, Transport, Storage, Disposal
I —— Danger of death or severe injuries from dangerous voltage
A A DANGERI » Disconnect the inverter from the AC grid before removing the
AC conductors.

» Verify absence of AC voltage before removing conductors.

DACEER Danger of death or severe injuries from danger voltage
{fi A —— Dangerous voltages can be present at the DC connections of the
inverter.
» Never disconnect the PV modules when the inverter is
connected to AC grid or DC disconnect is on. First, switch off the
AC conductors grid so that the inverter cannot feed energy into the
grid. Then, open the DC disconnect.
» Verify absence of DC voltage before removing conductors.

Danger of injury due to heavy weight
The inverter is heavy (see “11. Technical Data”, p. 71). Incorrect
handling can lead to injuries.

» The inverter must be lifted and carried by two people.

10.1 Removal
1. Switch off the AC breaker and verify absence of AC voltage.
2. Open the DC disconnect, verify the absence of DC voltage on both the inverter

and array sides, then disconnect PV array.

Remove DC and AC conductors and conduits from the inverter.
Unscrew the inverter from the wall bracket.

Lift the inverter from the wall bracket.

o0k w

10.2 Transport

Always transport the inverter in the original packaging or packaging of the same quality.

10.3 Storage

Always store the inverter in the original packaging or packaging of the same quality. Observe the
specifications relating to storage conditions described in Section 11: “Technical data”.

10.4 Disposal

Dispose of the inverter in an appropriate manner according to the legal requirements of your
country, state and municipality.
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1. Technical Data

INPUT (DC) PVI 3800TL PVI 5200TL PVI 6600TL PVI 7600TL

Max. recommended

PV power 4580 W, 6200 W, 8000 W, 9100 W,

Max. System
Voltage 600V

Operational
Voltage range 120 ... 550 V

Full power MPP

range 200... 500 V

Max. current 20A 15 Aper MPP tracker 18 A per MPP tracker 20 A per MPP tracker

Max. input short
circuit current 24 A 48 A (24 A per MPP tracker)
(Isc x 1.25)

Max. allowed Y
imbalance power 33%167%

DC disconnect Internal

MPP tracker 1 2 2 2

MPP efficiency 99.5%, dynamic

OUTPUT (AC) PVI 3800TL PVI 5200TL PVI 6600TL PVI 7600TL

Nominal power 3800 W 5200 W 6600 W 7600 W

Ve e 3300W @208V/  5200W@208V/  6600W@208V/  6600W @ 208V /
o[ 3800 W @ 240 V 5200 W @ 240 V 6600 W @ 240 V 7600 W @ 240 V

Voltage range -12%/+10%

Max. continuous
output current 164 27.5A 32A
Nominal frequency 60 Hz

Frequency range 59.3-60.5 Hz

Night consumption <2W

Total harmonic
distortion @ nominal <3%
power

Power factor @ .
nominal power Unity, >0.99

Max. output
overcurrent 28A 56A%
protection

Reactive power

capability Ves
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GENERAL
SPECIFICATION PVI 3800TL PVI 5200TL PVI 6600TL PVI 7600TL

Max efficiency 98.0%

. 97.5% @ 208V /
CEC efficiency 97.5% @ 240V
Operating -13 to +158 °F (-25 to +70 °C) /
temperature Derate above 122 °F (50 °C)

-40 to +185 °F
Storage temp. (40 to +85 °C)
Humidity 0...100%
Max.operating 2000 m above sea level
altitude
MECHANICAL
DESIGN PVI 3800TL PVI 5200TL PVI 6600TL PVI 7600TL
Dimensions . .
y 17.5x 15.8 x8.51in. 26.8x15.8x8.5in.

L x W x D inches
(Lx W x D mm) (445 x 401 x 216) (680 x 401 x 216 mm)
Weight 43 Ibs (19.5 kg) 65 Ibs. (29.5 kg)
Cooling Convection
AC connectors Screw terminals in connection box
DC connectors Screw terminals in connection box
Communication
interface R
Display 3 LEDs, 4-line LCD
Enclosure material Aluminum

1) Un-balanced PV input allowed, maximum input power for each MPP tracker is limited with 67% rating power and total input is
limited with 100% rating power. See section 4.7.

2) The maximum AC power value indicates the power an inverter might be able to deliver, but such a maximum AC power may not
necessarily be achieved.

3) Max. output fault current and duration is 140Apk, 2ms duration @208V, 116.8Apk, 6.15ms duration @240V.
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STANDARDS /
DIRECTIVES PVI 3800TL PVI 5200TL PVI 6600TL PVI 7600TL

Electronics

protection rating NEMA 4, [EC 60068-2-11 (Salt mist)

Safety UL 1741, CSA 22.2 No. 107-01
SW Approval UL 1998

Isolation Monitor
Interrupt (IMI) NEC 690.35, UL1741 CRD
Unintentional

Islanding protection IEEE 1547, IEEE 1547 1

EMC FCC part 15A & B, ICES-003

AFCI UL1699B (Type 1), NEC 690 2014

WARRANTY PVI 3800TL PVI 5200TL PVI 6600TL PVI 7600TL
Standard warranty 10 years

Utility interconnection voltage and frequency trip limits and trip times for all models:

Simulated utility source Maximum time (sec) at 60Hz
before cessation of current to the
Voltage (V) Frequency (Hz) simulated utility

<50% V Rated (60 Hz) 0.16
50% V<V >88%V Rated (60 Hz) 2
110% V <V <120% V Rated (60 Hz) 1

120% V=V Rated (60 Hz) 0.16

Rated f>60.5 0.16

Rated f>59.3 0.16

Trip limit and trip time accuracy for all models:

Voltage: +1V (L-L)
Frequency: +0.01Hz
Time: 1%, but not less than 100ms
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1.1 FCC Compliance Information

SOLECTRIA RENEWABLES, LLC. string inverters, Model PVI 3800TL, PVI 5200TL, PVI 6600TL
and PVI 7600TL.

This device complies with Part 15 of the FCC Rules. Operation is subject to the following
conditions:

(1) This device may not cause harmful interference, and
(2) This device must accept any interference, including interference that may cause undesired
operation.

Note: This equipment has been tested and found to comply with the limits for a Class B digital
device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable
protection against harmful interference in a residential installation. This equipment generates,
uses and can radiate radio frequency energy and, if not installed and used in accordance with
the instructions, may cause harmful interference to radio communications. However, there is no
guarantee that interference will not occur in a particular installation. If this equipment does cause
harmful interference to radio or television reception, which can be determined by turning the
equipment off and on, the user is encouraged to try to correct the interference by one or more of
the following measures:

. Reorient or relocate the receiving antenna

. Increase the separation between the equipment and the receiver

. Connect the equipment into an outlet on a circuit different from that to which the receiver is
connected.

. Consult the dealer or an experienced radio/TV technician for help.

. The user is cautioned that changes or modifications not expressly approved by SOLECTRIA
RENEWABLES could void the user's authority to operate this equipment.

Contact YASKAWA - SOLECTRIA SOLAR for more information:

YASKAWA - SOLECTRIA SOLAR

360 Merrimack Street

Building 9, Floor 2

Lawrence, MA 01843

USA
http://solectria.com/products/grid-tied-inverters/residential-tl-string-inverters/pvi-3800-
7600t/

Support E-mail:  service@solectria.com
Support Hotline: 978-683-9700
Monday to Friday from 8:30am to 5:00pm (apart from official Bank Holidays)

11.2 Canadian Compliance Information

This Class B digital apparatus complies with Canadian ICES-003.

DOCR 070366-D 83



12 Appendix

121 Overview of Setting Options

The following table contains an overview of all settings that can be made in the inverter.

Function /

Characteristic Short description Menu Manual chapter
. 200 Options
Yo “7.4 Options settings”
. For setting up the extended MPP 210 Shading
Shading tracking “7.4.1 Shading”

Display settings

110 Date and time

Date and time For setting the date and time “7 2.1 Date and time”

Date and time For setting the date and time formats 111 Format

format “7.2.2 Date and time formats”
. 120 Display settings
Contrast For setting the contrast “7 2.3 Contrast”
For selecting the display to be shown 800 Standard
Standard menu when no key has been pressed for a
certain period of time. “7.5 Standard menu”
Monitoring
For setting the RS-485 ID and the 150 RS-485
RS-485 settings baud rate and for switching the
termination resistor on and off “7.2.5 RS-485"
Showing statistics
Showing statistics 400 Production info
on the display “6. Production information”
Feed-in settings
Currency, revenue  For setting the currency and the 471 Feed-in settings
per kWh revenue per kWh “7.3 Grid feed-in settings”

84 DOCR 070366-D



12.2 Order Numbers
RS-485 cable

RS-485 connection cable

Cable for connecting inverters

Please contact Solectria for available options.

12.3 Overview of Menu Structure
12.3.1 "Go to menu" Function

You can use the “Go to menu” function to directly navigate to a

‘:::Fl HOTICE! particular menu.
ANS!

1. To open the Go to menu function, press and hold the key on the inverter for at least 3
seconds.

— Go to menu opens.

Go to menu

2. Press the key to enter the menu number.
— The first digit flashes.

3. Enter the first digit of the menu number using the keys. Press the key when you
are finished.

— The second digit flashes.
4. Enter the second and third digit in the same manner.
5. Press the key.

— The menu corresponding to the entered menu number is displayed.
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12.3.2 Installation Settings (100)

100 Installation

Explanation

130 Grid selection

Display the grid settings, change the grid

140 RS-485 Change RS-485 settings
110 Date and time Explanation

Date: 18/06/2013 Date

Time: 15:12:23 Time

111 Format Date and time formats
111 Format Explanation

Date: DD/MM/YYYY Date format

Time: 24h Time format (12h or 24h)
120 Display settings Explanation

Contrast: 10 1...10

130 Grid selection Explanation

131 View grid setup

Actual grid settings

132 Grid change Set a different grid
140 RS-485 Explanation
If multiple inverters are connected via RS-485,
ID: - then each inverter must have a different ID. (1
... 254)
Baud rate: Baud rate (2400 / 4800 / 9600 / 19200 / 38400)
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12.3.3  Shading (210)

Mode Explanation

Disable Monitoring is deactivated.

High High shading, time cycle: 0.5 hours
Medium Medium shading, time cycle: 2 hours
Low Low shading, time cycle: 4.5 hours
210 Shading Explanation

Mode Disable Disabled / High / Medium / Low

12.3.4  Production Information (400)

400 Production info

Explanation

Current power and energy values. Messages

ARSI on the current operating status.
420 Day statistics Statistics for the current day
430 Week statistics Statistics for the current calendar week

440 Month statistics

Statistics for the current calendar month

450 Year statistics

Statistics for the current calendar year

460 Total statistics

Statistics for the entire operating period

470 Feed-in settings

Settings for currency and revenue per kWh

480 Event journal

Messages off events

490 History

Power and energy value of latest 7 days

410 Current data

Explanation

411 Current overview

Current status

412 Current data AC

AC =AC side

416 Current data PV

PV = module side

41A Date and time

Date and time

41B Current insulation

Insulation resistance value
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411 Current overview

Explanation

Now: 200w

Current active power

Day: 2000Wh

Energy production current day

Normal operation

Current status messages

412 Current data AC Explanation

L1 voltage: -V Voltage

L1 Freq.: ---Hz Frequency

L1 Current: -=A Phase current
L1P: —-W Active power
LaQ: ---Var Apparent power
L1 DCinj.: ---mA Feed-in current

416 Current data PV

Explanation

PV1 Voltage: -V

Voltage on the PV side

PV1 Current: -—-A

Current on the PV side

41A Date and time Explanation
Date: 18.06.2013 Current date
Time: 15:05:19 Current time

41B Current insulation

Explanation

Riso: ----kQ

Insulation resistance at DC+
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420 Day statistics Explanation
421 Day statistics AC AC =AC side
422 Day statistics DC DC = DC side

423 Day statistics ISO

ISO = Insulation

430 Week statistics

440 Month statistics

450 Year statistics

460 Total statistics

470 Feed-in settings

480 Event journal

490 History

421 Day statistics AC Explanation

Energy: —Wh Energy

Runtime: -—-h Runtime

Revenue: --USD Revenue

L1 Imax: -—A Maximum current

L1 Pmax: —-W Maximum active power

L1 Qmax: ---Var Maximum apparent power
L1 Qmin: ---Var Minimum apparent power

431 Week statistics AC

441 Month statistics AC

451 Year statistics AC

461 Total statistics AC
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491 Day Explanation

Energy: —Wh Energy

Runtime: -—-h Runtime

Revenue: --USD Revenue

L1 Imax: -—A Maximum current

L1 Pmax: --W Maximum active power
L1 Qmax: ---Var Maximum apparent power
L1 Qmin: -—--Var Minimum apparent power
492 Day

493 Day

494 Day

495 Day

496 Day

497 Day

422 Day statistics DC Explanation

PV1 Imax: -—A Max. current

PV1 Umax: -V Max. voltage

PV1 Pmax: --W Max. power

432 Week statistics DC

442 Month statistics DC

452 Year statistics DC

462 Total statistics DC
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423 Day statistics ISO

Explanation

R ISO max: ---kQ

Max. insulation resistance

R ISO min: ---kQ

Min. insulation resistance

433 Week statistics 1ISO

443 Month statistics ISO

453 Year statistics ISO

463 Total statistics ISO

470 Feed-in settings

Explanation

Currency usD

Define the currency

USD / kWh: .4

Define the revenue pro kWh

480 Event journal

Explanation

481 External events

Overview of all external events and insulation/
grounding problems

482 Change events

Overview of all parameter changes

12.3.5 Diagnostics and Alarms (600)

The reports that are displayed depend on the grid configuration:

. Internal log (is always displayed)

600 Diagnostic&Alarm

Explanation

620 Internal log

Firmware update

13.3.6  Software Version/Inverter Data (700)

700 Inverter info

Explanation

710 Software vers.

Version of the installed software

720 Inverter data

Production date and serial number
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12.3.7  Standard Menu (800)

800 Standard menu

Explanation

Menu number:

Number of the menu that is to be displayed as
the standard menu.

92
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13 Glossary

AC
Abbreviation for “Alternating Current”.

AHJ
Abbreviation for “Authority Having Jurisdiction” (electrical inspector).

Basic Insulation
Insulation to provide basic protection against electric shock.

CEC
Abbreviation for the California Energy Commission

CEC Efficiency
CEC Efficiency is the California Energy Commission Efficiency rating, a performance rating for
modules and inverters based on the real environment that a system will be in.

CSA
Abbreviation for the Canadian Standards Association.

DC
Abbreviation for “Direct Current”.

EMC
The Electro-Magnetic Compatibility (EMC) concerns the technical of the mutual influencing of elec-
trical devices through electromagnetic fields caused by them.

FCC
Federal Communications Commission.

Galvanic isolation
No conductive connection between two component parts.

GEC
Grounding Electrode Conductor

GET
Grounding Electrode Terminal

|IEEE
The Institute of Electrical and Electronics Engineers or IEEE is an international non-profit, profes-
sional organization for the advancement of technology related to electricity.

IMI
Isolation Monitor Interrupter

Isc
Short Circuit Current

Local utility company
A local utility company is a company that distributes electricity over the grid.
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MPP
The Maximum Power Point is the point on the current-voltage (I-V) curve of an array or string, where
the product of current and voltage has it's maximum value.

NEC
The National Electrical Code (NEC), or NFPA 70, is a United States standard for the safe installation
of electrical wiring and equipment.

Power dissipation
Power dissipation is designated as the difference between absorbed power and power of a device
or process yielded. Power dissipation is released mainly as heat.

PV cell
PV cells are large-surface photodiodes which convert light energy (generally sunlight) into electrical
energy. This comes about by utilization of the photoelectric effect (photovoltaic).

PV array
System comprising of a number of PV modules.

PV module
Part of a PV generator; converts PV energy into electrical energy.

RJ-45
Abbreviation for standardized eight-pole electrical connector connection. RJ stands for Registered
Jack (standardized socket).

RS-485 (EIA485)
Differential voltage interface on which the genuine signal is transmitted on one core and the ne-
gated (or negative) signal on the other core.

Inverter
An electrical device which converts DC direct voltage into AC voltage and/or direct current into
alternating current.

String
Designates a group of electrical PV modules amended in series.

UL
Stands for Underwriters Laboratory, an organization that sets standards for different product cat-
egories and tests products to make sure they meet the standards.

Voc
Open Circuit Voltage
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14 Certificates

Please check our web site for the most recent certificates at: http://solectria.com/products/grid-
tied-inverters/residential-tl-string-inverters/pvi-3800-7600tl/.

AN
Certificate of Compliance

Certificate: 2716237 Master Contract: 260655

7\
@)=

Project: 70029191 Date Issued: April 21, 2015

Issued to: SOLECTRIA RENEWABLES LLC
Bldg 9 360 Merrimack Street
Lawrence,
MA 01843,
USA

Attention: Chinedu Igbokwe

The products listed below are eligible to bear the CSA Mark shown
with adjacent indicators 'C' and 'US’ for Canada and US or with adjacent
indicator 'US' for US only or without either indicator for Canada only

s P o Kyle Song
Issued by: Kyle Song

C us

PRODUCTS

CLASS 5311 09 - POWER SUPPLIES - Distributed Generation Power Systems Equipment
CLASS 5311 89 - POWER SUPPLIES - Distributed Generation - Power Systems Equipment
- Certified to U.S. Standards

Transformerless Utility Interactive Inverter, Models PVI-3000TL, PVI-3800TL, PVI-5200TL, PVI-6600TL and
PVI-7600TL, permanently connected.

Notes:
For details related to rating, size, configuration, etc. reference should be made to the CSA Certification Record.

APPLICABLE REQUIREMENTS

CSA-C22.2 No.107.1-01 - General Use Power Supplies

*UL Std No. 1741-Second Edition - Inverters, Converters, Controllers and Interconnection System
Equipment For Use With Distributed Energy Sources (January 28, 2010)
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15 Warranty

The current warranty and RMA statement for the product is available online at http://solectria.
com/support/documentation/warranty-information/grid-tied-inverter-warranty-letter/. If you do not
have access to the internet or to request a copy to be mailed to you, please contact the Customer
Service Department 978-683-9700.
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http://solectria.com/products/grid-tied-inverters/residential-tl-string-inverters/pvi-3800-7600tl/

Yaskawa - Solectria Solar

360 Merrimack Street

Building 9, 2nd floor

Lawrence, Massachusetts 01843

USA

Tel: 978.683.9700

Fax: 978.683.9702
Sales/General Info: inverters@solectria.com
Customer Support: service@solectria.com
Website: www.solectria.com

A YASKAWA

5613209901 SOLECTRIASOLAR
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